
Tutorial:  Creating a Customer Satisfaction Survey 

The following tutorial will demonstrate how to create a customer satisfaction survey using the 
AskAnywhere® Editor.  The tutorial will cover the following areas: 
 

1. changing background color and inserting graphics 
2. creating a title and introduction 
3. creating questions and response sets, including an open-ended question and skip/filter 

instructions 
4. inserting a previously created questionnaire into this questionnaire 

 
 
This tutorial assumes that by now you are comfortable locating and opening the AskAnywhere® Editor 
program on your computer.  However, should you need to review how to access and open the program 
please return to the index to see either the QuickStart guide or the “Getting Started Section” of the full 
manual (both of which are available in either HTML or PDF formats). 
 
Additionally, this tutorial assumes that you are familiar with some of the basic features of the 
AskAnywhere® Editor, such as saving a questionnaire, that were covered in the first tutorial, “Creating a 
Basic Demographic Survey.” 
 
For the purposes of this tutorial, we will pretend that you a member of a marketing research that has been 
hired by Casa Taco Olé, a regional restaurant chain, to design a customer satisfaction survey that can be 
distributed to their customers. 

Creating the Questionnaire 

To begin creating your customer satisfaction survey, first open the AskAnywhere® Editor program on 
your computer.  Remember, when the program launches, it automatically opens a new, untitled 
questionnaire page. 

Changing Background Color and Inserting Graphics 

The default background color setting for all surveys is light gray.  You want to change the background 
color of your survey to white.  To change the background color, go to the Utilities menu and select 
Background Color.  (See the figure below.) 
 

Note:  To improve readability, the editor window pictured below has been 
reduced in size; your default window size is larger than that shown in the 
tutorials. 

 
 



 
Selecting Background Color 

The following Color window, displaying the color palette, will open.   
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Color Palette Window 

Select the color you wish to choose for your background, in this case white, by clicking on that color and 
click Ok. 
 

Note:  The following step is for demonstration purposes only; you will not 
actually have a Casa Taco Olé logo saved as a file.  You may use any JPG or 
GIF file you have saved on your computer to complete the following stage of the 
tutorial. 

 
On this first page of the survey, you want to include the Casa Taco Olé logo, which your marketing 
company has been given as an image file and which you have stored on your computer.  To add the logo 
to the survey page, click on the Add Graphics to Page button located in the main toolbar.  (See the 
figure below.) 
 
 

 
Add Graphics to Page Button 

The following new window, which prompts you to get either primary or secondary files will open.  (See 
figure below.) 
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Get File Window 

To insert the file containing the Casa Taco Olé logo onto your survey page, click the Get button.  The 
Open File window, pictured below, will open. 
 
 

 
Open File Window 

Locate the file you need, select that file and either click Open or double click on the file.  (See the figure 
below.) 
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Selecting a Graphic File 

Note:  For this particular step in the tutorial, you may select any JPG or GIF file 
you have saved on the hard drive of your computer.  For demonstration purposes, 
this tutorial displays a file containing a logo for Casa Taco Olé. 

 
When the Open File window closes, click Ok.  Your survey page should now contain a graphic file.  (See 
the figure below for a sample page containing a graphic.) 
 
 

 
Page Containing Sample Graphic 

Note:  You may need to adjust the size of the graphic frame to fully display the 
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image you selected.  To adjust the size of the graphic frame, click on the frame to 
highlight it.  A small box will appear in the lower right corner of the graphic 
frame (See the figure above.)  Click on that small box, then hold and drag your 
mouse cursor to adjust the size of the answer frame. 

Creating a Survey Title and Introduction 

You want to begin by creating a title for your survey and writing a small introduction to your survey.  
Your introduction should explain the purpose of gathering the information you hope to collect through the 
survey. 
 
To create the title for the survey, open the Question Editing window by clicking on the Add Question to 
Page button and then type the following: 
 

Customer Satisfaction Survey 
 
When you have finished typing the text for the survey title, you may also want to choose the font, size, 
and color of the text as well as choose the justification for the text. 
 

Note:  The default font for questions is Serif, while the default text size is 18 
points and the default color is black.  The default justification is left. 

 
When finished typing and formatting the text of your title, click Ok.   
 
To add the introduction to your survey, click once more on the Add Question to Page button to open the 
Question Editing window and type the following: 
 

We want to be sure that you enjoyed your dining experience at our restaurant 
today.  Please take a few minutes to answer the following questions.  We 
welcome your feedback and will use your responses along with those of other 
customers as guidelines to improve our overall performance and service to our 
customers. 

 
When finished typing the text, you may also want to choose the type style, size, and color of the font for 
this introduction. 

 
Click Ok when finished typing and formatting your text.  Your survey page should now contain at three 
frames—one graphic and two text—and look similar to the page pictured below. 
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Page with Logo, Title, and Introduction to Survey 

Note:  If you have not already done so, you may want to save your questionnaire 
at this point, by going to the File menu and clicking on Save As… or Save and 
naming the questionnaire file when prompted to do so.  Remember to save your 
work often. 

 

Creating Questions and Response Sets 

You are now ready to begin adding questions and response sets to your survey.  You will need to begin 
your questions on a new page.  To add another page to this survey, click on the Append Blank Page 
button in the main toolbar of the Editor program window.  (See the figure below.) 
 

 
Append Blank Page Button 

A new page will be added to the survey. 
 
You first want to determine what food and beverage survey respondents.  To add your first question, open 
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the Question Editing window by clicking on the Add Question to Page button located in the main 
toolbar.  When the Question Editing window opens, type the following text: 
 

Please indicate your food and beverage purchased: 
 
Refer to the figure below for a view of the text in the Question Editing window. 
 
 

 
Text Entered in the Question Editing Window 

 
Click Ok when finished entering and formatting your text.  Your second survey page be similar to the one 
pictured below: 
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Sample Page Two with Question Frame 

To add your answer set, click on the Add Answer to Page button in the main toolbar 
Refer to the figure below and enter the displayed text in blank cells under the column heading “Item 
Text” in the Answer Editing window. 
 
 

 
Entering Answer Item Text 

Note:  At this point, you may want to format your answer item text by changing 
the font style, size, or color. The default text settings for answer items are 18 
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point, Serif in Black. 
 
Click Ok when finished entering and formatting the answer item text.  Your page should now look 
similar to the one displayed below. 
 
 

 
Sample Survey Page Two with Question and Response Set 

The first four questions of the survey are related to the respondents’ experience with the Casa Taco Olé 
staff and the service; therefore, you are going to put them on the same survey page.   
 
Add a new page to the survey by clicking on the Append Blank Page button in the main toolbar.  After 
the new page is added, click on the Add Question to Page button in the main toolbar to open the 
Question Editing window.  When the Question Editing window opens, enter the following text: 
 
 

Please rate your level of satisfaction with the staff and service at this Casa Taco Olé.  
Check one answer for each. 

 
When finished typing and formatting your text, click Ok. 
 
Click on the Add Question to Page button to open the Question Editing window once again.  Enter the 
following text. 
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Friendliness of Staff 

 
Click Ok when finished entering and formatting your text. 
 
Next, open the Answer Editing window by clicking on the Add Answer to Page button in the main 
toolbar. Enter the following text under the “Item Text” heading in the Answer Editing window: 
 

Exceeded My Expectations 
Met My Expectations 
Did Not Meet My Expectations 

 
Click Ok when finished entering and formatting text.  Your survey page should now look similar to the 
one pictured below. 
 
 

 
Sample Survey Page Three Containing One Complete Question and Answer Set 

You will add three more questions and response sets in a similar manner.  Refer to the figure below to see 
the completed page. 
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Note:  After you have added the first answer frame containing the response set, 
you can simply click on the answer frame to highlight it, go to the Edit menu and 
select Copy and then paste the frame on the page three more times instead of 
opening the Answer Editing window and entering the text for the response set 
three more times. 

 
 
 

 
Completed Page Three of Sample Survey 

Note:  To fit four questions and response sets on one page, you will need to both 
reposition and resize each of your question and answer frames. 

 
The next two questions of your survey ask respondents their opinions of the overall menu selection and 
value of the menu.  Since these questions are related, you will put them on one page in the survey. 
 
First, add the next page to your survey by clicking on the Append Blank Page button.  Then, open the 
Question Editing window by clicking on the Add Question to Page button.  When the Question Editing 
window opens, type the following as a short introduction to this pair of questions: 
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Please rate your satisfaction with the both the selection choices and value of the 
entire Casa Taco Olé menu.  Check one answer for each. 
 

Click Ok when finished entering and formatting the text. 
 
Click on the Add Question to Page button once again and type the following as the text for the first 
question on this page: 
 

Menu Selection Variety 
 
When finished typing and formatting the text, click Ok. 
 
Next, click on the Add Answer to Page button to open the Answer Editing window.  Enter the following 
text under the “Item Text” heading in the Answer Editing window: 
 

Exceeded My Expectations 
Met My Expectations 
Did Not Meet My Expectations 

 
Click Ok when finished. 
 
You will add the second question and response set on this page in a similar manner.  Refer to the figure 
below to see the completed page. 
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Completed Page Four of Sample Survey 

The next six questions of the survey ask respondents to consider their specific food order.  The first 
question seeks to find out if customers received the correct order, and a follow-up question for those who 
did not receive the correct order asks respondents to explain what was wrong with their order.  The final 
four questions of this section ask respondents to rate their level of satisfaction on four aspects of the order 
they received. 
 
Add the next page to your survey by clicking on the Append Blank Page button in the main toolbar.  
Open the Question Editing window by clicking on the Add Question to Page button.  When the 
Question Editing window opens, type the following text: 
 

Did we fill your order correctly? 
 
Click Ok when finished typing and formatting your text. 
 
Next, open the Answer Editing window and, referring to the figure below, enter the following text under 
the heading “Item Text”.   
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Entering Text for Answer Items 

When finished typing and formatting the text, click Ok.  The survey page should now look similar to the 
one displayed below. 
 
 

 
Page Five, Containing One Question and Response Set 

If respondents check “NO” for this question, you want to be able to find out what was wrong with the 
order, so you want to add a second question and response set to gather this information.  To add a second 
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question, click again on the Add Question to Page button, which will open the Question Editing 
window.  Type the following text: 
 

If no, what was wrong with the order? 
 
Click Ok when finished typing and formatting your text. 
 
Next, hold down the Ctrl key while clicking on the Add Answer to Page button.  A modified version of 
the Answer Editing window, pictured below, will open. 
 
 

 
Modified Answer Editing Window 

Click on the first cell under the heading “Type”.  This cell currently (See the figure above.) reads “Text”.  
Then, go to the Type pull-down menu and select Label.  (See the figure below.) 
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Selecting Label 

After selecting Label, type the following text in the first open cell under “Item Text”: 
 

Please tell us what was wrong with the order: 
 
Then, click in the next open cell under the heading “Type”; go to the Type pull-down menu and select 
Text-Variable (or Ctrl + 3).  (See the figure below.)   
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Selecting Text-Variable 

The following window, prompting you to enter the maximum number of characters you want respondents 
to be able to enter in the text field, will open: 
 
 

 
Text Limit Window 

 
 

18 



Enter the number you wish to set as the maximum limit, and then click Ok. 
 

Note:  For this particular answer, the maximum limit of 2000 may be most 
appropriate.  Setting the maximum text limit to 2000 will let respondents respond 
with answers up to 2000 characters in length. 

 
The limit window will close and return you to the Answer Editing window.  Click Ok.  Your survey page 
should be similar to the one pictured below. 
 
 

 
Completed Page Five of Sample Survey 

 
Note:  In the figure above, “Item 2” represents the text box respondents will be 
able to enter their responses in when viewing the survey.  All the frames on this 
page have been resized and repositioned in an effort to make the page easier to 
read.  The size of “Item 2” in the Editor window corresponds to the size of the 
text box respondents will see when taking the survey.  To view the size of your 
text box, you may want to test your survey (Under the Utilities menu, select Test) 
and then adjust the size of “Item 2” and, thus, the text box, accordingly. 
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In addition to adding the second question to this page of the survey, you also want to add skip/filter 
instructions so that the survey will automatically filter off the second question on this page if respondents 
select “Yes” in response to the first question on this page. 
 
To add your skip instructions, go to the Utilities menu and select Skip Instructions (or Ctrl + K or hold 
down the Ctrl button while clicking on an answer frame).  (See the figure below.) 
 
 

 
Selecting Skip Instructions from the Utilities Menu 

The Skip/Filter Instructions window, pictured below, will open. 
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Skip/Filter Instructions Window 

This particular skip will be a basic skip to, the most common type of skip, which will move respondents 
from one question to another specified question based on their response to a given response set.  To create 
the skip to instructions for this question, you will need two pieces of information:  1) the question/answer 
number or the variable name for the first question on this page, and 2) the answer value that will cause the 
skip. 
 
The question/answer set that you want the skip/filter instructions to apply to is Question 8.  You can 
determine the question number by double clicking on the answer frame for the “Yes,” “No” response set 
and looking at the number next to the heading “Answer:” in the upper left corner of the Answer Editing 
window.  Or, if you held down the Ctrl key while clicking on the “Yes,” “No” response set answer frame 
to open the Skip/Filter Instructions window, the question number will be displayed in the upper left 
corner of this window as well. (Refer to the figure above.) 
 
The value for a “Yes” response to Question 8 is “1”, while the value of a “No” response to is “2”.  So, if a 
respondent responds by checking “Yes” or “1”, you want the questionnaire to skip to Question 10.  Now 
that you have both the question number and the response value, you can set the skip/filter instructions. 
 
To set the skip to criteria, type the following in the first blank cell under the heading “Skip/Filter Criteria” 
in the Skip/Filter Instructions window: 
 

Q8=1 
 
Next, type the number of the question you want the questionnaire to skip to in the first open cell under the 
heading “Skip to Q#”.  In this case, you want the questionnaire to skip Question 9 and go to Question 10, 
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which you will create in the next step of this tutorial.  (Refer to the figure below to see the completed skip 
instructions for this step.) 
 
 

 
Completed Skip Instructions 

When finished entering the skip instructions, simply close the Skip/Filer Instructions window by 
clicking on the X in the upper right corner of the window. 
 
Add a new page to the questionnaire by clicking on the Append Blank Page button. 
 
The next four survey questions will ask respondents to rate their impressions of the food they were 
served, so you will place them on the same page like you did the questions regarding service.  To begin 
adding the questions, click on the Add Question to Page button in the main toolbar.  When the Question 
Editing window opens, type the following as an introduction to these four questions: 
 

Please rate your level of satisfaction with the following aspects of the food 
received in your order.  Check one answer for each. 

 
When finished typing and formatting the text, click Ok. 
 
Click on the Add Question to Page button once again and type the following for the text of your first 
question: 
 

Temperature of the Food 
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Open the Answer Editing window by clicking on the Add Answer to Page button.  Under the heading, 
“Item Text,” type the same three options used for previous answers: 
 

Exceeded My Expectations 
Met My Expectations 
Did Not Meet My Expectations 

 
Click Ok when finished typing and formatting the answer item text.  (See the figure below.) 
 
 

 
Page Six of Survey with One Question and Response Set 

 
To add the other three questions to this page, follow the same procedure.  Refer to the figure below for the 
text of the next three questions as well as an example of what the sixth page of your survey should be 
similar to. 
 

Note:  To fit four question frames as well as four answer frames on the page, you 
may need to both resize and reposition each frame. 
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Completed Page Six of Survey 

You are now ready to complete the final two questions of your survey, which will ask respondents to rate 
their satisfaction with two aspects of the restaurant itself.  These questions will be displayed on the same 
survey page.  To add the next page to the survey, click the Append Blank Page button in the main 
toolbar of the Editor.   
 
When the new page opens, click the Add Question to Page button to open the Question Editing window.   
 
Type the following text as a short preface to these last two questions: 
 

Please rate your level of satisfaction with the following aspects of the Casa Taco 
Olé you visited today. Check one response for each. 

 
Click Ok when finished typing and formatting your text. 
 
Open the Question Editing window once again by clicking on the Add Question to Page button in the 
main toolbar of the Editor.  Type the following text for the first question on this page: 
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Cleanliness of the Restaurant 
 
Click Ok when finished typing and formatting text. 
 
Open the Answer Editing window by clicking on the Add Answer to Page button in the main toolbar of 
the Editor.  In the empty cells under the heading, “Item Text,” type the following: 
 

Exceeded My Expectations 
Met My Expectations 
Did Not Meet My Expectations 

 
Click Ok when finished typing and formatting the text for this set of response items.   
 
Open the Question Editing window once again, and type the following text for the second question on 
this survey page: 
 
  Atmosphere of the Restaurant 
 
Click Ok when finished. 
 
Then, open the Answer Editing window by clicking on the Add Answer to Page button again, and enter 
the same text that you used in the previous response set for this response set.  Click Ok when finished.  
Refer to the figure below to see a sample of page seven of the survey. 
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Completed Sample Page Seven 

The following section of this tutorial will take you step-by-step through creating a thank you page to end 
your survey. 

Adding a Thank You Page 

Now that you have finished adding questions and response sets to your survey, you may want to add one 
last page to the survey so you can add some brief text thanking respondents for taking the time to 
participate in the survey. 
 
To add another page, click the Append Blank Page button located in the main toolbar of the Editor.  
When the new page is added to the questionnaire, open the Question Editing window by clicking on the 
Add Question to Page button located in the main toolbar.  When the Question Editing window opens, 
enter the following text: 
 

Thank you for taking the time to respond to the Casa Taco Olé Dining Survey.  
We are committed to providing quality food and quality service.  As our 
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customers, you are best qualified to assess the quality of our food and services, so 
we welcome your comments. 

 
Click Ok when finished entering and formatting the text. 
 
Once you have added a question frame to this page, survey respondents will need some way to end the 
survey.  So, open the Answer Editing window by clicking on the Add Answer to Page button.  Refer to 
the figure below for an example of how to prompt respondents to end the survey. 
 
 

 
Sample Final Page of Survey 

You have now completed the customer satisfaction survey.  Be sure to save the questionnaire by going to 
the file menu and choosing Save.  If you have not previously saved the survey, you will be prompted to 
enter a file name before clicking Save.  
 
After reviewing a draft of the contents of the survey, the management of Casa Taco Olé wants to add 
some demographic questions so they can develop a better picture of whom they are serving.  The 
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following section of this tutorial will walk you through inserting a previously created demographic survey 
into the customer satisfaction survey you just created. 

Inserting a Previously Saved Questionnaire File 

To insert one questionnaire file into another questionnaire, first go to the File menu and select Insert File.  
(See the figure below.) 
 
 

 
Selecting Insert File from the File Menu 

The Insert File window, pictured below, will open: 
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Insert File Window 

Next, enter the page number that you want to insert the file before.  In this case, you would enter page 8, 
which is the last page—the thank you page—of the customer satisfaction survey you just created.  Then, 
click Ok. 
 
The Open File window, pictured below, will open: 
 
 

 
Open File Window 

 
Select the questionnaire file you wish to insert in the current questionnaire.  In this case, you want to 
insert the demographic questionnaire that you created in the previous tutorial.  This questionnaire is 
located in the demographic folder.  So, you will need to double click on the demographic folder to open 
it, and then you will select the demographic file.  (See the figure below.) 
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Selecting the Demographic Survey File 

Once you have selected the file, click Ok. 
 
The demographic survey should now be inserted in the customer satisfaction survey. 
 

Note:  The demographic survey, which contains questions regarding gender, age, 
marital status, education level, and annual income, for instance, was originally 
created as a separate survey.  You may want to review the demographic questions 
to see if they are necessary or appropriate for this customer satisfaction survey. 

 
Move through the survey, including the newly inserted pages, to determine if any changes need to be 
made to formatting.  
 

Note:  Because the demographic questions were originally created as a separate 
survey, the formatting (i.e. font style, size, and color) for both questions and 
response sets on these pages will be different than those of the customer 
satisfaction survey.  You may want to change the font style, size, and color on 
these newly inserted pages to match those of the customer satisfaction survey 
pages. 

 
Additionally, you may want to check not only the position and the size but also the number of questions 
and response sets per page for the demographic questions; some questions and response sets may be able 
to be combined on one page, thus shortening the overall page length of your survey. 
 
On the first page containing demographic questions you want to add a brief introduction to the 
demographic questions.  Go to the first page containing demographic questions, page eight, and click on 
the Add Question to Page button in the main tool bar of the Editor to open the Question Editing 
window.  When the Question Editing window opens, enter the following text as an introduction to the 
demographic questions in your survey: 
 

Answers to the following questions will be used for statistical purposes only. 
 
Click Ok when finished typing and formatting your text. 
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Your customer satisfaction survey is now complete.  Save any changes you have made by going to the file 
menu and selecting Save or by pressing Ctrl + S. 
 
You may also want to test the entire customer satisfaction survey to see how it operates for respondents.  
You may test the survey by going to the Utilities menu and selecting Test (Ctrl + B). 
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